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Please note that this user guide only contains information on the functionality outlined above. For the complete user guide please click

on the following link: http://www?2.londonstockexchangegroup.com/IEl-User-Guide
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Introduction
I

London Stock Exchange PLC has over 20 years of experience as the UK’s National Numbering Agency for assignment of International Securities
Identification Numbers (ISINs) and Classification of Financial Instruments (CFIs) and was also endorsed by the Regulatory Oversight Committee (ROC)

as a Local Operating Unit (LOU) for the global allocation of Legal Entity Identifiers (LEI) and are accredited by GLEIF www.gleif.org

London Stock Exchange’s LEI, also known as the International Entity Identifier (IEl), is issued to legal entities according to the agreed Principles outlined
by the ROC and GLEIF (www.gleif.org). The LEI codes will be issued and maintained via UnaVista, the London Stock Exchange Group’s hosted matching

and reconciliation platform.

Legal Entity Identifier (LEI) Solution Overview

The LEI solution enables you to Request and Maintain your LEI record/s including the ability to monitor your LEI Status, view your LEI details, add

documentation and fulfil Annual Renewal obligations.
You can also submit 10 or more LEI requests using the Bulk Request functionality and renew 10 or more LEIs using the Bulk Annual Renewal feature.

Additionally, you can search the consolidated universe of LEI data, as well as download data files and challenge a LEI record under the responsibility of

the London Stock Exchange if you believe the details to be incorrect.

Version 2.1 Page 3


http://www.leiroc.org/publications/gls/lou_20140824_2.pdf

Registration

CORPORATE

2475, London
4% Stock Exchange Group

To access the LEI database, click the following link: www2.londonstockexchangegroup.com/reqgister-for-lei. The Registration page will be displayed. As

standard, all free services will be available upon registration. Please complete the Registration details:

Please Note: Registration details will be used to validate
that self-registration principle for LEI requests is being
adhered to. Therefore, enter the full entity name of the
organisation you work for in the Company Name field.

To register, click the Register button on the Login
screen. Then Enter your email in the User
Registration window and you will be sent a link.
Click the link which will then take you to the
Registration Screen

—Please login

Email:

Password:

User registrati
Please fill in the email address of the account to be registered

<

Terms and conditions

Please check the box to confirm you accept the website Terms and Conditions of Use.

Registration X

Welcome

The UnaYista platform hosts a number of free and subscription data solutions such as:

- International Entity Identifier (IET) and Pre-LEI consolidated lookup service - B

UK Conponate Aetians tniqut Reference (LOAT) oo sorvie " 1. Complete all the mandatory
- SEDOL Masterfile (subscription service) fields. The mandato ry fields
are highlighted in red.

- Corporate Events Diary (subscription service)

Registration to the UnaVista platform will automatically provide access to all free services,
including the functionality to request the allocation of International Entity Identifiers (IET).

Customers can have subscription services enabled following confirmation of a valid Customer
MNumber.

User Details

/2. If you have additional

Title v Email

First Name Last Name subscription services, such as

Phone Number Job Title SEDOL MaSte rf|le, yOu can

Company Name Entity Type = add them to your profile from
R the Subscription Services

Address Details section on the Registration

Address 1 Address 2 page.

Address 3 City

Country | Postal/Zip Code

Euhscriptinn ::rviu:sl a / \

Do you have a SEDOL Masterfile user licence? [F 3 Please ensure th at you |

SEDOL Masterfile Customer Number

have accepted the T&Cs by
selecting the Terms and
Conditions of Use check box
at the bottom of the
Registration form.

If you would like more information about the SEDDL Masterfile then please click here

If you would like access to the Corporate Events Diary then please tick here O

If you would like more information about the Corporate Events Diary then please click here

Privacy

The London S|

Fn neawida an

es your privacy seriol

rondick makat vaca

. We collect and use personal information

b and infaems v shoak s,

wank neadurks

-
¥

O0<t—m
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Welcome Screen

When you successfully log on to the UnaVista portal, the following UnaVista Welcome screen is displayed.

Flev Naiigaton= Tooks> Help~ (B tome
'« Navigation Settings O News |f 53] Dashboar
09 Jul 2 2 Username Stephen Munro
Domain: Data Portal v View As: v
Search:  LE] Y 0
—
«|LE1
3/ g9 LEI Consoldsted Search 6 q
AW iE0es 0 The News tab displays any updates or
;-jj{:j"_‘f”’“’“‘” news from the UnaVista team.
«| UK ISIN Search 7. ) \‘
K15 e If configured, the ‘

o 200 e vk i Dashboard displays the
pre-set charts giving a
snapshot of data in the

2 B
The Search facility | =
enab|es you to | UnaVista Trade Repository Aggregation Data

search for LEIs system.
using part of the
entity name.
UnaWsta-One vie\r{of our data
The Folder Tree displays the folders 3
available to you. These may differ s gt i) _
depending on your access permissions. o SR 4 «

Click the number to the right of a folder to
access the folder contents.

When you click the number, the contents of
the folder will be displayed in the right pane.

The Welcome Screen
displays the recent news or
updates from UnaVista as
well as general contact
information.

%
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LEI — Search and Request LEI
- __________000_00__]

The LEI — Search and Request LEI section includes the following topics, click the link to access the respective topic:

Search LEI Record(s)

= View LEI Record Details

= Reguesting an LEI

= Enter LEI Data

= Pay and Submit LEI Request

= Bulk Request Information

= Challenging an LEI Record
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Search LEI Record(s)
I

The Search facility in the Navigation Settings region enables you to search the database for an existing LEI. The applicable LEI matches are
displayed in the right hand panel from the LEI Consolidated View folder.

~

Type part of the entity name you wish

to search an LEI code for in the
Search field, and press ENTER or
click the Search button.

CORPORATE

Entities that contain the searched word will
be displayed in the right pane. The relevant
LEI will also be displayed.

/
File + Mavigation= Tools» Help+ n Home fl [Data Portal] LET : London Stock
(< Navigation Settings 7] LEI Consolidated View
Options = | Filters = d Request LET
Domain: | Data Portal WAs: | Stephen Muno | ¥ 3 N
D‘ LET Status [1# LET Event Entity Status Entify Event LoU | LE OfficialEntityName
Seac 15 pr O |
1 D IS5UED Validated Active No event IEI 5403000WOVX16Z551E37 LONDON STOCK EXCHANGE GROUP PENSION SCHEME - LSE SECTION
London Stock Search 2 [ 1SSUED Validated Active Namechange  IED  213300WAVVOPSASN2205 LONDON STOCK EXCHANGE LET LIMITED
E] LEI 3 D IS5UED Validated Active No event IEI 213800D1ET4ESWTWWD28 LONDON STOCK EXCHANGE PLC
| LE| Consolidated Search 1.46M 4[| 185LED Validated Active No event IEl  21330054EHSROMPQIPSS LONDON STOCK, EXCHANGE GROUP HOLDINGS LIMITED
g My LEI Data 0 5 D IS5UED Validated Active No event IEI 213800601CCNIBZVCLIS LONDON STOCK EXCHANGE GROUP PENSION SCHEME - LCH SECTION
You will notice that following return of search results, the
Request LEI button will be displayed to the upper right corner of
the page. Click this button to submit a request for a LEI.
For more details, please refer to the Request a LEI topic of this
user guide.
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View LEI Record Detalls
I

Once you search and find the LEI record, you can easily view the LEI details and export the details into a PDF or text format.

2. Once you select a record the Challenge
Record, View LEI, and Select for
Renewal buttons will be enabled.

1. To view the LEI details, select the record by clicking
on the record or selecting the check box next to the
record.

Optipns ~ | Filters = -'?g _"3 Challenge Record View LET Select for Renewal Request LEI
‘ LET Status [1# LEI Event Entity Status Entity Event Lou LEI OfficialEntityName AlternateEntityt
1 I ISSUED Validated Artive Mo event IEI 21380054EHGROMPQIPGS LONDON STOCK EXCHANGE GROUP HOLDINGS LIMITED

5 3 1
Bpnm - Expert #z POF— Expart A3 et |

London
Stock Exchange

3. Click the View LEI button.
The details of the selected

LEl is displayed.

Official Entity Name:

LONDOM STOCK EXCHANGE GROUP HOLDINGS LIMITED

You can print the
LEI Details or export

Legal Form: PRIVATE LIMITED COMPANY
itin a PDF or text

LEI: 21380054EHER OMPQIPES fo rm at_
First Assignment Date: 13-09-2013
LEI Status: Active
Primary LOU: IEl

10 10
HeadQuarters Address: PATERNOSTER LegalFormation Address: PATERMOSTER

SQUARE SQUARE
HeadQuarters City: LONDON LegalFormation City: LONDON

HeadQuarters Country:
HeadQuarters PostCode:

}JggED KINGDOM | & aIFormation Country:

EC4M 7LS LegalFormation PostCode:

Official Business Registry:
Official Business Registry Ref:
Website:

COMPANIES HOUSE
0R7 95362
hitp him

UNITED KINGDOM
- GB

EC4M 7LS
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Requesting an LEI

Requesting an LEI is a 3 step process: 1. Search LEI database 2. Complete Request LEI template 3. Submit Credit Card payment

Before you submit a request for an LEI, you must search the LEI database to see if an LEI already exists (see point 1 below). For more details on
how to search an LEI, please refer to the Search LEI Record(s) topic in this user guide.

If the searched LEI exists in the system, it will be displayed in the right hand panel from the LEI Consolidated View tab.

If you have more than 10 LEI requests to submit, please use the Bulk Request Information feature.

1 Elgeir Cgtrgrz tsh(;t?nntgy hame within 2. If no match is found, to request a h
o 9 g ‘ . new LEI, click the Request LEI
This will return potential matches within button.
the LEI Consolidated View. The Request LEI button will only be
See ‘London Stock’ as an example below displayed following a search for an LEI. o
N\
File » Navigation= Tools» Help- n Homa lj [Data Portal] LET : London Stock
(<] Navigation Settings £ (7] LEI Consolidated View
Options = | Filters+ | & Request LET
Domain: | Data Portal v | ViewAs: Stsphen Myffo v ° 3
D ‘ LEI Status [1# LET Event Entity Status Entity Event Lo | LEI OfficialEntityName
Search: |LEI v
1|[E | ISSUED Validated Active No event [El  5493000WOVX16Z55IE37 LONDON STOCK EXCHANGE GROUP PENSION SCHEME - LSE SECTION
London Stock == 2| [E@ | 155UED Validated Active Namechange  IEL  213800WAVVOPSESN2205 LONDON STOCK EXCHANGE LET LIMITED
[«|LEX = EE | ISSUED Validated Active No event [El  213B800DIEI4BSWTWWD28 LONDON STOCK EXCHANGE PLC
J | gg LEI Consolidated Search 1.46M 4 |]| 155UED Validated Active No event IEl  21380054EHSROMPQIPES LONDON STOCK EXCHANGE GROUP HOLDINGS LIMITED
| g My LEI Data 0 5| [ | ISSUED Validated Active No event [El  213800601CCNIBZVCLIS LONDON STOCK EXCHANGE GROUP PENSION SCHEME - LCH SECTION

Once you click the Request LEI button, a new window is opened as shown on pages 10 -11 enabling you to submit a request for a new LEI
To submit the payment so the LEI request can be validated please see page 12
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Requesting an LEI
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The Create screen enables you to complete and submit the different details related to the new LEI request that you want to create.

Create

1. Select Yes. If
you third party
authorised to
apply on behalf of
the entity please
also attach a
document to
confirm.

——
SR

2. Complete

all the mandatory
fields; these are
highlighted in red

3. Tips are

provided for all
the fields. To
view the Tip,
hover your
mouse or clic

icon. @ .

= | Confirm Authorisation

/4. Upload

Confirm - 71 Uploa:l_ ) ! ;
Ruthorieed ) = [¥] puhoricaton (B, Authorisation
l-lt'ltyll.ameand Legal Form < Registration Authrity F(_)rm if you are a
ﬁ:gm \ | oyt B third party applying
Alternate Entity Registry ) for an LEI on
Name i i
ol pre b v behalf of the Legal
phtity Entity Category 2 s |_||| Entity
g | || Entity Legal Form 593 - v ?.ﬂ;ﬁwmiw |
\ | Fund Hanager TiEn — XaE .~ Upload supporting
= | Hdadquarters Address =] Legal Formation Address K Document such as
‘ Unit Number :r.ldljst;\lumber | Unit Number i Fund prospectus,
ine 1
Line2 @ Trust deed,
Line 2@ Articles of
Lie 4@ Incorporation, if
Town/Cry @ | | Counry/state @ Toun/City @ | | county/state gy this information is
Comry @ | || Region @ 7 Couny @ | ]¥| Region @ - not publically
Postcode/ZIP @ | | Mail Routing Pusncodelepq_j [ | Mail Routing available on a
Copy Addrese @ [ Copy Address @[] Registration
« | Other Address ~| Other Address 2 A
< DirectParant < UltimateParant AUthOfIl’y.
Parent Hame | - Parent Name @ | v
DirectParentLET UltimatePare... Note: You can add
Excsption Reasan *| || Beception Reason v multiple documents
Relationship Type 7 LenE \ Relationship Type [z Jpiatatatzn ¥ once you have
- - — e created a draft.
Gl Please refer to the

[Note: Your LEI Request will only be completed once you make a payment.

when initially opening the form.

5. Once you have completed all the mandatory fields, click
on Create. You will notice that the button is Grayed out

Manage your LEI
Request topic.

& 4
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Enter LEI Data
e

The LEI data has two main sections, the LEI Entity data and the LEI Parent data. Both sections need to be completed before you can request a LEI.

The LEI Entity data in the first section of the
create form consists of information about
your entity such as the name, type of entity,
registry details and address details
(headquarters address and legal/registered
address).

The LEI Parent data or Level 2 data is
information of your entity’s direct and
ultimate parent as per accounting
consolidating standards.

- Select Parent Name from the drop down
list if the Parent has as LEI.

- If Parent does not have a LEI yet, enter
the full name of the Parent and
complete all fields including address and
registry details of the Parent.
(Alternatively apply for the Parent LEI, if
required).

- If a Parent does not exist or cannot be
disclosed, choose ‘N/A’ from the drop
down and complete the Exception
Reason field.

Related Identifiers can be provided
to assist in validation process.

Please see the LEI Level 2 Data Help

&heet for further information. /

Create

| Confirm Authorisation

CORPORATE

Upload
Confirm = eari
Authorised () Im ] T xEm
| Entity Name and Legal Form =|Registration Autharity
Official Entity Country of
Name @ [ ] Business [ 1
Alternate Entity Registry
Name @ Registration [ 1+
. . Authri

Anglicised Entity Entity Category | N/A = ‘"“'i

. Autharity Entity | 1
Legal Formation « ISOEntityLegal |OTHER - Please Spechh =
Country @ [ [ ] 1SOE OTHER - Passe Spacity Y

it x
LegalForm @ ‘ ‘., Website Document () 1)
+ Headquarters Address + | Legal Formation Address
Address Number Unit Number Address Number Unit Number
Line1 @ [ | Line1 @ [ 1
Line2 Line2 @
Town/City @ ] [ Tawn/City @ | county/state @
Country |~ Region @ [ I Country |~ Region @ [ ~
Postcode/ZIP @ | mail Routing Postcode/ZIP @ | Wail Routing
Copy Address @ [ Copy Address @ [
~ | Other Address ~ | Other Address 2
* | DirectParent = |UltimateParent
Parent Name @ | |+ Parent Name @ | |+
OR v OR v
Exception Reason Exception Reason
Relationship Type R ~ Relationship Type S -
Documents Documents

Qualifier + Upload Parent Qualifier ~  Upload Ultimate
e Proaf e Proof
HQ Address Line Legal Address HQ Address Line Legal Address
1 Lime 1 1 Line 1
HQ City Legal Gity HQ City Legal City
HQ Country ~  Legal Country v HQ Country v Legal Country v
HQ Region ~  Legal Region ~ HQ Region ~  Legal Region v
HQ Post Code Legal Post Code HQ Post Code Legal Post Code

Copy Address )

Registration

\Aum:'ﬂ

+|Related Identifiers
ISIN

FRN @

GLEIF Link on Level 2 Data:
https://www.gleif.org/en/lei-data/access-and-use-lei-data/level-2-data-who-owns-whom

<

Register Entity ID

Copy Address @

Registration
Authority

eic

Cancel

LEI ROC Policy on Level 2 Data:

&

Register Entity 1D

https://www.gleif.org/en/lei-data/access-and-use-lei-data/level-2-data-who-owns-whom/lei-roc-

policy-on-level-2-data
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Pay and Submit LEI Request
I

The My LEI Data folder enables you to make payments and submit your LEI requests. To make a payment, please follow the below 7 steps:

2. Select the check box next to the record for which you need to make a payment

1. Click the NUMBER to the\ 3. Click the Submit Card Pymnt button.

right of the My LEI Data 4. Enter your VAT Number or choose the VAT option that applies to you from the
folder. VAT screen as shown below

The LEI request(s) are 5. Choose the number of years you wish to renew. Then click OK

displayed in the right pane.

AN /

|« Navigation Settings Options ~ | 2 _‘.’3' Subarmit Card Pyt | Challenge Recard | Wiew LEI | Sel
Domain:  [atka Partal |:| Ij Daocs Requestar LEl Status  LEl Event
1 ER 1 Silvia.Diasi@lseg.com  Draft
Search: [ B T I P
2 |:| 1 Silvis.Diss@@lzey.com  PEMDING Awveaiting Y alickstion
Search & |:| 1 Silvia.Diss@lseg.com  Active Waliclsted
|« |LEL additional Field(s) X
= “LE ed User Input
Ww LEIData ¥AT of registered
LE] Bulk Request Information 3 user (EU
- company):
4l gy LEI Dially Export Flles 1287 ¥AT exempt (EU [
company):

Statutory body 7]
{EU company):

¥AT N/A (Non-EU [
Company}:

K Cancel
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Pay and Submit LEI Request
I

the Payment Form as shown below: Card button to proceed with the payment. The Payment

L 5. Accept the Terms and Conditions to continue to J 7. Enter your credit card details and click the Pay By
Status screen is displayed as shown below:

Information 3

i ) One or more of the following is true for the selected rows:

By clicking "yes” to continue your submission, you are thereby accepting the LEI Terms and
Conditions of Issue.

Are you sure you want to continue?

Wes Mo

‘Your card detailzs are now being verified for processing. You will shortly receive an emall confirming the
status of your credit card payment

card details

View Detail \ b

Y

L 6. Click on Load Payment Form to further input your J Please close this window to continue,

| Load Payment Form

required, you will be contacted by an email. If no email is received, your payment may not have been processed, please contact lei@Iseg.com if this is the case

LNote: On payment submission you will receive an email response confirming the status of your payment. Once your LEI request is validated or if more information is J
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Bulk Request Information
I

The Bulk Request feature enables you to submit 10 or more LEI requests at a time. For more information on Bulk Request, please refer the LEI Bulk
Request User Manual available in the LEI Bulk Request Information folder.

. . 2. Information on Bulk Request is covered in the LEI Bulk
1. To access the LEI Bulk Request details, click on q

the number displayed next to the LEI Bulk Request - Requetf]t el Manuall. lick the D load File i
Information folder. The LEI bulk request details are 0 access the user manuaj, click the Lownload File icon.

dplavediiieyiohinale, You can also as the LEI Bulk Request Template using the
L=

Download file icon.

[« ] Navigation Settings = Options ~ | Filters~ | 2 4y
) = | FileType FilzDiate Fil=
Domain: |Data Portal w | Wiew As: | Stephen Munro b -
- 1([m | LET Bulk Request Ref Data 08 Jul 2019 ==
Search: |12 o e @ I .
Z | [E] | LEI Bulk Request User Manual 24 Apr 2019 ==
Search Sea c M [ | LEI Bulk Request Template 2% Jun 2018 [E=|
[=]LET
(= =) LEI Consolidated Search 1.46M
les My LEI Data o
e SPA LEI Data o
les LEI Bulk Request Information 3

3. Download the LEI Request Ref Data files
required to populate some of the data fields
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an LEI Record
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Any user can challenge an LEI record if they believe that the details submitted are incorrect. You can only challenge the LEI records that are
currently held by the London Stock Exchange LEI Limited within our system. For other LEIs you can challenge at www.gleif.org

[+ Navigation Settings & (=] L¥I Consolidated View
Optios~ | Filters - '?g _"{-’g Challenge Record View LEI Select for Renewsl
Domain: | Data Portal v |View As: Stephen Munro |V
LET Status LETEvent | Enfity Status | Entity Event LOU | LEI OfficialEntityName
Searcht 12 7] et QL] |
1 ISSUED Velidated  Active No event IEI 213800D1EI4BIWTWWD28 LONDON STOCK EXCHANGE PLC
london stock exchange|  Search

[+]Ler
Blg LEI Consolidated Search 1.46M

& My LEI Data 0

& LEI Bulk Request Information 3
Additional Field(s) e

User Input

Rz=eme 3. Enter the Reason for the |

challenge and select the
appropriate Effective Date.
Effective Date: |
) You can also upload a document to
Upload File support your challenge.
File: Mo File chosen

Ok | Cancel |

(Select the record that you want to |

challenge by clicking the check
box next to the record.

2. Click the Challenge Record
button. The Additional Field(s)
screen is displayed as shown
below.

Note: The Challenge Record button
will be enabled only when you select a

\@'d. /

L Once you submit the challenge, you will receive an email confirming the challenge submission. A response to the Challenge will be received within three working

days of submission.
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Contact Us
]

Full operational support for LEI requests is available from 09:00 to 17:00, UK business days.

Contact details are as follows:

LEl Customer Support

For further information: www.lseg.com/lei

Telephone: +44 (0)207 797 3300

Email: LEI@lseq.com
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